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INTRODUCTION

SMX-M8xx Series Cameras - are megapixel CMOS cameras with USB2.0 interface
suitable for scientific and industrial applications.

The cameras are designed for capturing, streaming and storing high quality digital
images.

The SMX-M8xx Series Cameras are available in three modifications:

SMX-M81M (1.3 Megapixel, monochrome)
SMX-M82C (2 Megapixel, color)
SMX-M83C (3 Megapixel, color)

All the SMX-M8xx Cameras feature:

Communication interface - USB2.0

Form factor - a duralumin housing with C/CS - mount interface

All the SMX-M8xx Cameras benefit:

High speed

Low power consumption

No external power supply required
Ease of use

Compact size

The programmable functions include viewport window settings, adjustable exposure
time and gain, selectable sensor clock frequency and image decimation, flipping image
horizontally and vertically. The SMX-M8xx Series Camera can be used in microscopy,
video conferencing, webcasting, surveillance and security systems, etc.

Introduction:
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Camera Specifications

Table 1-1 Output Video and Camera Control Characteristics

SMX-M81M Camera

SMX-M82C Camera

SMX-M83C Camera

Maximum
resolutions of
output window

1280x1024, full
resolution mode

1600 x 1200, full
resolution mode

2048 x 1536, full
resolution mode

Max Frame rate at
resolution

(24MHz2)*

15 fps at 1280 x 1024
24 fps at 1024 x 768
37 fps at 800 x 600
40 fps at 768 x 576
54.7 fps at 640 x 480
89.5 fps at 400 x 400
166 fps at 320x240

10 fps at 1600x1200
14 fps at 1280 x 1024
22.7 fps at 1024 x 768
34.6 fps at 800 x 600
37 fps at 768 x 576
50 fps at 640 x 480
79.6 fps at 400 x 400
145 fps at 320x240

6 fps at 2048x1536

10 fps at 1600x1200
13.9 fps at 1280 x 1024
21.9fps at 1024 x 768
33 fps at 800 x 600
35.7 fps at 768 x 576
48 fps at 640 x 480

75 fps at 400 x 400
138.5 fps at 320x240

Output bit per pixel

Selectable, 8 bitsor 10
bits

Selectable, 8 bits or 10
bits

Selectable, 8 bitsor 10
bits

Lookup table

Software, converts 10
bits of imaging chip's
ADC to 8 bits of output
for user selected 8 bits
mode

Software, converts 10
bits of imaging chip's
ADC to 8 bits of output
for user selected 8 bits
mode

Software, converts 10
bits of imaging chip's
ADC to 8 bits of output
for user selected 8 bits
mode

Pixel rates

12 MHz, 24 MHz

12 MHz, 24 MHz

12 MHz, 24 MHz

Exposure range

0.06 - 65.7 ms (24 MHz,
1280x 1024, 1:1); More
than 2 sec with fps
decrease

0.07-96.91 ms (24
MHz, 1600 x 1024, 1:1);
More than 2.5 sec with
fps decrease

0.09-156.92 ms (24
MHz, 2048 x 1536, 1:1);
More than 200 sec
with fps decrease

Pixel Gain Control

Programmable
(Hardware): 48 gain
levels from 1 to 15

Programmable
(Hardware): 48 gain
levels from 1to 15
Gain controls forR, G,
B: 48 gain levels from 1
to 15

Programmable
(Hardware):161 gain
levels from 1 to 128
Gain controls for R, G,
B: 161 gain levels from
1to 128

Introduction: Camera Specifications
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SMX-M81M Camera

SMX-M82C Camera

SMX-M83C Camera

Output window
modes

View port (from 1280 x
1024 to 8 x 8 with 2
pixels/2 lines step
positioning) Frame
Decimation (1:1, 1:2,
1:4, 1:8) Horizontal
mirroring, hardware
Vertical flipping,
hardware

View port (from 1600 x
1200 to 8 x 8 with 2
pixels/2 lines step
positioning) Frame
Decimation (1:1, 1:2,
1:4, 1:8) Horizontal
mirroring, hardware
Vertical flipping,
hardware

View port (from 2048 x
1536 to 8 x 8 with 2
pixels/2 lines step
positioning) Frame
Decimation 1:1, 1:2,
1:3,1:4,1:5,1:6,1:7,1:8
Frame Binning: 1:1,
1:2, 1:3, 1:4 Horizontal
mirroring, hardware
Vertical flipping,
hardware

Gamma, brightness
and contrast
control

Programmable with
lookup table, software
gamma correction

Programmable with
lookup table, software
gamma correction

Programmable with
lookup table, software
gamma correction

* Listed frame rate values at the defined resolutions are not the maximal possible. Increasing of frame rate

can be done by reducing the current Exposure value (the lower Exposure the higher frame rate), hiding the
active video window from the display, running the camera with a fast speed computer, etc

Table 1-2 Imaging Chip Characteristics

SMX-M81M Camera

SMX-M82C Camera

SMX-M83C Camera

Type

Mono inch 1.3
megapixel CMOS
sensor manufactured
by Micron Technology,
Inc

Color inch2
megapixel CMOS
sensor manufactured
by Micron Technology,
Inc

Color inch3
megapixel CMOS
sensor manufactured
by Micron Technology,
Inc

Pixel Size

52umx5.2um

4.2 umx4.2um

3.2umx3.2um

Image Array Size

8.4 mm diagonal

8.4 mm diagonal

8.4 mm diagonal

Shutter

Rolling

Rolling

Rolling (Optional
Global Reset)

Scanning mode

Progressive

Progressive

Progressive

ADC Resolution 10 bit 10 bit 10 bit

Sensitivity 2.1 V/lux-sec 1.2 V/lux-sec (550nm)  >1.0 V/lux-sec
(550nm)

Dynamic Range 68.2dB >61dB 61dB

Introduction: Camera Specifications
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Table 1-3 Camera Electrical Characteristics

SMX-M81M Camera

SMX-M82C Camera

SMX-M83C Camera

Supply Voltage

5V supplied by USB2.0
interface

5V supplied by USB2.0
interface

5V supplied by USB2.0
interface

Table 1-4 Camera Physical Characteristics

SMX-M81M Camera

SMX-M82C Camera

SMX-M83C Camera

Operating 0to+70 C 0to+60 C 0to+60 C
Temperature

Dimensions, L x D 46 x31.5 mm 46 x31.5 mm 46 x31.5 mm
Lens Mount Type C/CS - mount C/CS - mount C/CS - mount
Camera Housing Duralumin Duralumin Duralumin

material

Table 1-5 Camera Interface Characteristics

SMX-M81M Camera

SMX-M82C Camera

SMX-M83C Camera

Interface Type

USB2.0, 480Mbps

USB2.0, 480Mbps

USB2.0, 480Mbps

Connector Type

USB mini-B, 5 pin

USB mini-B, 5 pin

USB mini-B, 5 pin

Table 1-6 System Requirements

SMX-M81M Camera

SMX-M82C Camera

SMX-M83C Camera

Operating
System

Windows XP
Professional SP1or SP2
Windows Server 2003
SP1

Windows XP
Professional SP1or SP2
Windows Server 2003
SP1

Windows XP
Professional SP1or SP2
Windows Server 2003
SP1

Processor

Pentium 4, 3 GHz or
higher, HT or dual-
core recommended

Pentium 4, 3 GHz or
higher, HT or dual-
core recommended

Pentium 4, 3 GHz or
higher, HT or dual-
core recommended

RAM

256MB, recommended
384Mb

256MB, recommended
384Mb

256MB, recommended
384Mb

Hard Disk Space

5 MB for installation
plus additional space
for captured images

5 MB for installation
plus additional space
for captured images

5 MB for installation
plus additional space
for captured images

Video

24 bit True Color, 8 MB
video memory

24 bit True Color, 8 MB
video memory

24 bit True Color, 8 MB
video memory

Introduction: Camera Specifications
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Table 1-6 System Requirements

SMX-M81M Camera SMX-M82C Camera SMX-M83C Camera
USB USB2.0 Host USB2.0 Host USB2.0 Host
Controller, Controller, Controller,
recommended Intel recommended Intel recommended Intel
integrated host integrated host integrated host
controller controller controller

SMX-M8xx Camera Kit

The SMX-M8xx Camera Kit includes the following items:
® The SMX-M8xx Series Camera

® The SMX-M8xx Series USB2.0 Cameras Software Package which is available for down-
loading via the provided URL

USB A to USB mini-B cable (optional)
Tripod adapter (optional)

C-mount adapter with IR-cut filter (optional)

C-mount adapter (optional)

Introduction: SMX-M8xx Camera Kit
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INSTALLATION

Install (if needed) USB2.0 adapter card into your PC. Install all required drivers. Refer to
your USB2.0 adapter card manufacturer's User Guide for detailed instructions for
hardware and software installation.

Automatic Camera Installation

Browse to the downloaded via URL SMXM8X_CD folder. Open setup.exe to start the
SMX-M8xx Series USB2.0 Software Package installation.

Welcome to the SMX-M8x USB2.0 Camera Software Setup Wizard will appear (see
Figure 2-1 Welcome to the SMX-M8xx USB2.0 Camera Software Setup Wizard window).

15/ Setup - SMX-M8x USB2.0 Camera Software (=)

Welcome to the SMX-M8x USB2.0
Camera Software Setup Wizard

Thiz will install Skix<-M8x USB2.0 Camera Software on wour
computer,

Itiz recommended that you close all ather applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

[ Mest> |[ Cancel ]

Figure 2-1 Welcome to the SMX-M8xx USB2.0 Camera Software Setup Wizard window

In order to proceed with the SMX-M8xx USB2.0 Camera Software Package
installation click the Next button.

On the third step the SMX-M8xx USB2.0 Camera Software Setup Wizard will
determine whether your system configuration meets system requirements of the SMX-
M8xx USB2.0 Camera (see Table 1-6 System Requirements).

The following system information will be displayed:
® OS version

® USB2.0 Host Controller availability

® Memory Size

Installation: Automatic Camera Installation
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® CPU Speed

Each point of the system information will be marked by its status according to the
compatibility with the SMX-M8xx USB2.0 Camera.

The current system information will be marked as one of the following:
® Ok (Found - for USB2.0 Host Controller)

® Warning

® Fail

System information that completely satisfy the SMX-M8xx USB2.0 Camera
requirements will be marked by Ok (for USB2.0 Host Controller - Found). In this case the
SMX-M8xx USB2.0 Camera will work properly (see Figure 2-2 Setup Wizard, System
information window: the case of satisfactory system configuration).

15/ Setup - SMX-M8x USB2.0 Camera Software (=)

System Information
System Information collects your spstem configuration information.

Suppoart technicians require specific information about your computer when they
are troubleshooting your configuration.

O5: Windows XP Pro SP2 - Ok
TUSE 2.0 Host Controller - Found
MMemory: 5420b - Ok

CPU Speed: 42040z - Ok

[ Fefresh

[ < Back ][ Mest » ][ Cancel ]

Figure 2-2 Setup Wizard, System information window: the case of satisfactory system configuration

The Warning status will be displayed in cases when the SMX-M8xx USB2.0 Camera
can be installed but might not work properly (see Figure 2-3 Setup Wizard, System
information window: the case of warning system configuration).

Installation: Automatic Camera Installation
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ﬁl Setup - SMX-MBx USB2.0 Camera Software

System Information
System Information collects your spstem configuration information.

Suppoart technicians require specific information about your computer when they
are troubleshooting your configuration.

|OS: Windows XP Pro SP1 - Ok
USB 2.0 Host Controller - Found
MMemory: 5120db - Ok

CPU Speed: 24040z -

[ < Back ” Mest » ][ Cancel ]

Figure 2-3 Setup Wizard, System information window: the case of warning system configuration

The Fail status will be displayed in cases when the SMX-M8xx USB2.0 Camera will not

work at all with current system configuration (see Figure 2-4 The SMX-M8xx Setup Wizard:
failed to detect USB2.0 Host Controller).

ﬁl Setup - SMX-MBx USB2.0 Camera Software

System Information
System Information collects your spstem configuration information.

Suppoart technicians require specific information about your computer when they
are troubleshooting your configuration.

|OS: Windows XP Pro SP1 - Ok
USB 2.0 Host Controller - Fail
MMemory: 5120db - Ok
CPU Speed: 24040z -

[ < Back ” Mest » ][ Cancel ]

Figure 2-4 The SMX-M8xx Setup Wizard: failed to detect USB2.0 Host Controller

In any of these cases click the Next button.

If the system information was marked as Warning or Fail, the Error message will appear
and you will be asked to update your system configuration (see Figure 2-5 Error message
box when the SMX-M8xx Setup Wizard failed to detect USB2.0 Host Controller).

Installation: Automatic Camera Installation
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Note:

B

System Information
System Information collects your spstem configuration information.

Support technicians require specific information about your computer when they
are troubleshooting your configuration.

Warning

\y Current CPU Speed is less than 2.9 GHz and is not recommended For this hardware usage.,

Recommended configuration:
05 - Windows ¥P Professional SP1 or SP2Windows 2003;
USEZ.0 Intel integrated host controller;
CPU - 2,9 GHz or higher;
Memary Size - 256 MBE or more,

[ Ok H Cancel ]
Refresh
[ < Back ” Mext » ][ Cancel ]

Figure 2-5 Error message box when the SMX-M8xx Setup Wizard failed to detect USB2.0 Host
Controller

It is recommended to update your system configuration in the case of Warning status, otherwise the device
might not work properly

It is strongly recommended to update the system configuration in the case of Fail status, otherwise the device will
not work at all

If all the system information was marked as Ok, the next window of the SMX-M8xx
USB2.0 Camera Setup Wizard will appear. Follow easy-on-screen recommendations
and when ready press the Install button (see Figure 2-6 The SMX-M8xx Setup Wizard: ready
to install).

ﬁ%‘ Setup - SMX-MBx USB2.0 Camera Software

Ready to Install

Setup iz now ready to begin installing Skx-MEx USB2.0 Camera Software on your
computer,

Click Install to continue with the installation, or click Back if you want to review or
change any settings.

Destination location:
C:\Program FileghSumizhShx-k8x USB2.0 Camera

Start Menu folder:
SumizhSMx-t8x USE2.0 Camera

[ <Back || Install |[ Cancel ]

Figure 2-6 The SMX-M8xx Setup Wizard: ready to install

Installation: Automatic Camera Installation
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The SMX-M8xx USB2.0 Camera Setup Wizard will install the SMX-M8xx USB2.0
Camera Software Package and USB2.0 camera driver.

When done, in the Completing the SMX-M8xx USB2.0 Camera Software Setup
Wizard window additionally choose:

® Install a TWAIN driver (see chapter “Guidelines for Using TWAIN Driver”)

® Create Desk Topicon
® Create Quick Launch icon
® Launch the SMX-M8xx USB2.0 Camera Application Program after finishing

Click the Finish button and wait while TWAIN and/or Direct Show drivers are installed, if
it was selected (see Figure 2-7 Completing the SMX M8x USB2.0 Camera Software Setup
Wizard).

15/ Setup - SMX-M8x USB2.0 Camera Software (=)

Completing the SMX-M8x USB2.0
Camera Software Setup Wizard

Setup has finished instaling S-S« USE2.0 Camera
Software on your computer. The application may be launched
by selecting the installed icons.

Click Finizh to exit Setup.

Create a desklop icon

Launch Skx-b8x USE2.0 Camera Application Program
Install a T\WAIM driver

Figure 2-7 Completing the SMX M8x USB2.0 Camera Software Setup Wizard

Note:  TWAIN driver can be also installed separately, using the \Sumix\SMXM8xx USB2.0 Camera\Drivers\TWAIN folder.
Browse the Sumix folder that appears after the SMX-M8xx USB2.0 Camera Software Setup Wizard installa-
tion and run the TWAIN driver setup (see chapter “Installation”)

Manual Hardware Installation

The camera installation using the Found New Hardware Wizard on Windows XP
operating system is described below. On Windows 2000 the installation wizard slightly
differs, although, it is built on the same principles.

Note:  The details in the look of the screenshots may vary depending on your operating system version and configura-
tion

Installation: Manual Hardware Installation
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Connect the camera to your computer with the USB cable. The Found New Hardware
message will appear in the right corner of the Taskbar (see Figure 2-8 Found New Hardware

message in the Task bar).

er Found New Hardware

©EN f'@

Video Device

Figure 2-8 Found New Hardware message in the Task bar

Then the Found New Hardware Wizard will start up (see Figure 2-9 Found New Hardware

Wizard: welcome window).

Found Mew Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thiz wizard helpz you install software for:

S8 Series USB2.0 Camera

Z:') If your hardware came with an installation CD
“2E or floppy disk. insert it now.

Wwhat do you want the wizard to do?

(O Install fram a list ar zpecific location (Advanced)

Click Mest to continue.

[ Mest » ][ Cancel ]

Figure 2-9 Found New Hardware Wizard: welcome window

Leave as it is suggested by default 'Install the software automatically
(Recommended)' and click the Next button to go to the next step of the device
installation.

The Found New Hardware Wizard automatically will search for the software for your
video device (see Figure 2-10 Found New hardware Wizard: searching for needed files).

Installation: Manual Hardware Installation
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Found Mew Hardware Wizard

Please wait while the wizard searches.__. .

:@ S8 Series USB2.0 Camera

Cancel

Figure 2-10 Found New hardware Wizard: searching for needed files

You may be prompted for manufacturer's disk to be inserted (see Figure 2-11 Found New

Hardware Wizard: Insert Disk message box).

Insert Disk

f.} Please insert the Compact Disc labeled 'Sumix
\\@ Installation dizk' into wour CO-ROM drive (E:) and then

click OF.

“Y'ou can alzo click OF. if you want files to be copied
from an alternate location, such as a floppy disk or a
hetwark server.

Figure 2-11 Found New Hardware Wizard: Insert Disk message box

Browse to the SMXM8X.inf file which is normally located in the Drivers folder of the
SMXM8X_CD (see Figure 2-12 Found New Hardware Wizard: Files Needed message box).

Files Needed
« The file 'Shx-t 3 sps' on Sumix Installation disk is
(), Thefle
“

Type the path where the file iz located, and then click
oK.

LCopy filez from:

i Files\ Sunis\SMX-ME< USB2.0 CameraiDiivers [v]

Figure 2-12 Found New Hardware Wizard: Files Needed message box

When done, the Driver Files Search Results window will be displayed (see Figure 2-13
Completing the Found New Hardware Wizard).

Installation: Manual Hardware Installation
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| Found New Hardware Wizard

Completing the Found New
Hardware Wizard

5

The wizard haz finished installing the software for,

w=m SMAMEX Series USB2.0C.
J efies amera

Click Finish ta close the wizard.

Finizh

Figure 2-13 Completing the Found New Hardware Wizard

Press the Finish button. Windows will warn you that the SMX-M8xx Camera driver
does not contain Microsoft digital signature. In order to proceed with the camera
installation click Continue anyway (Yes in Windows 2000) in the Digital Signature
window (see Figure 2-14 Software has not passed Windows Logo Testing message box).

Hardware Installation

] E The zoftware you are installing for thiz hardware:
L

Imaging devices

hasz not paszed Windows Logo testing ta verify its compatibility

with Windows XP. [Tell me why this testing iz impaortant. )

Continuing your i llation of this sof may impair
or destabilize the t operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

I Continue Anpay I | STOF Installation |

Figure 2-14 Software has not passed Windows Logo Testing message box

Removing the SMX-M8xx Camera

Removing the Software

To remove the SMX-M8xx USB2.0 Camera Software Package click Start > Control
Panel > Add/Remove Programs (Start >Settings> Control panel > Add or Remove
Programs under Windows 2000). Find the SMX-M8x USB2.0 Camera Software in the
registered applications list (see Figure 2-15 Removing the SMXM8xx USB2.0 Camera Software)
and click the Change/Remove button. A message to confirm the removal will appear
(see Figure 2-16 Removal Application Prompt).

Installation: Removing the SMX-M8xx Camera
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. ) Add or Remove Programs E]@
- |
@ Currently installed programs: Sort by | Mame hdl
Change or s ] . ~
o ! S View & Control Size  E7IME 2
Pragrams g Sx150 USB2.0 Camera Software Size  33.84MB
g S4x155 USB2.0 Camera Software Size  27.47MB
ift 2 SMx-160 USB2.0 Camera Software Size 2.28MB
Add M
Progams | & SMKM7%USB2.0 Camers Software Size  BEEME
g SMX-M8X USB2.0 Camera Software Size 2,48MB
:;I Click here for support information. Used  freguently
Add/Remove . . . Last Used On 12.03.2006
Windows To change thiz program or remaove it from your computer, click Change/Remove. Change/Remove
Components
Set Program
Access and
Defaults

Figure 2-15 Removing the SMXM8xx USB2.0 Camera Software

| SMX-M8X USB2.0 Camera Software Uninstall

P

\‘_.\/ Are you sure you want to completely remove SE-MEX USB2.0 Camera Software and all of its components?

[ Yes ] [ HNo |

Figure 2-16 Removal Application Prompt

To remove the SMXM8xx Camera Application, click Yes. The SMX-M8xx Camera
Software will be removed from your computer.

Removing the Hardware

To remove the SMX-M8xx USB2.0 Camera from your computer, connect the camera
and click Start > Control panel > System (under Windows 2000 click Start > Settings
> Control Panel > System).

In the System Properties window, select the Hardware tab and click the Device
Manager button (see Figure 2-17 System Properties window).

Installation: Removing the SMX-M8xx Camera
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System Properties
System Restore Automatic Updates Femote
General Computer Marme Advanced

Add Hardweare Wwizard
§ The Add Hardware “Wizard helps you install hardware.

Add Hardware ‘Wizard

Device Manager

The Device Manager listz all the hardware devices installed
on your computer. Uze the Device Manager to change the
properties of any device.

[ Diiver Signing ] I Device Manager

Hardware Profiles

Hardware profiles provide a way for you to set up and store
different hardware configurations.

Hardware Profiles

[ Ok, H Cancel ]

Figure 2-17 System Properties window

The Device Manager window will open. Choose Imaging devices and do the

following:

1. Highlight the SMX-M8xx Series USB2.0 Camera

2. Right-click and select Uninstall (see Figure 2-18 Device Manager window: removing the

SMX-M8xx Series USB2.0 Camera)

3. Click OKin the Confirm Device Removal prompt (see Figure 2-19 Confirm Device

Removal prompt)

The SMX-M8xx USB2.0 Camera will be removed from your computer.

Installation: Removing the SMX-M8xx Camera
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( Device Manager E]@\

File  Action Wiew Help
g 2 =Ra
=& many

‘J Computer

“g# Disk drives

§ Display adapters

i DVDJCD-ROM drives
=) Floppy disk controllers

& Floppy disk drives
= IDE ATAJATAPT controllers
=8 Imaging devices
=8 SMX-M3¥ Series USB2.0 Came*~

%5 Keyboards Update Driver...
") Mice and ather pointing devices Disable

i Manitars Uninstall
HE Metwork adapters
+- & Ports (COM &LPT)
+ ﬁ Processars Properties
+-®), sound, video and game controllers

+- by System devices
+ Universal Serial Bus controllers

- [E- F- - -

4
4
4
4

Scan for hardware changes

Uninstalls the driver for the selected device,

Figure 2-18 Device Manager window: removing the SMX-M8xx Series USB2.0 Camera

Confirm Device Removal

:-9 S8 Series USB2.0 Camera

Warning: Y'ou are about to uninstall this device from your system.

[ oK |[ Cancel ]

Figure 2-19 Confirm Device Removal prompt

Updating the Hardware

To update the SMX-M8xx USB2.0 Camera with a newer driver, do the following:

1. Connect the camera to your computer

2. Open the Device Manager window (Start> Settings> Control Panel> System> Hard-
ware tab)

3. Click Imaging devices, then SMX-M8xx Series USB2.0 Camera

4. Right-click and select Update Driver... (see Figure 2-20 Device Manager window: updat-
ing of the SMX-M8xx USB2.0 Camera driver)

5. Run the Hardware Update Wizard that will appear - follow easy-on-screen instruc-
tions that the Wizard will suggest (see Figure 2-21 Hardware Update Wizard: welcome
window)

Installation: Updating the Hardware
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Device Manager E]@

File  Action Wiew Help
g 2 =R

=2 many

+ _éComputer

+-age Disk drives
+-# Display adapters
+ b DYDJCD-ROM drives
e
e
e

=) Floppy disk controllers
ﬁ Floppy disk drives
=2 IDE ATAJATAPT controllers
—|-=8 Imaging devices
=4 SMX-MEX Series USEZ2.0 Can=- .
58 SMY-MEX Series USEZ,0 Car | IPdats Driver,
Zz» Keyboards Disable
") Mice and other pointing devices Uninstal

'é s Scan for hardware changes
@ Metwork adapters
5 Ports (COM & LPT) Properties

ﬁ Processars
@, sound, video and game controllers

System devices
Universal Serial Bus controllers

Launches the Hardware Update Wizard for the selected device,

F- - - E- F- - -

Figure 2-20 Device Manager window: updating of the SMX-M8xx USB2.0 Camera driver

Hardware Update Wizard

Welcome to the Hardware Update
PN Wizard
N

Thiz wizard helpz you install software for:

S8 Series USB2.0 Camera

Z:') If your hardware came with an installation CD
“2E or floppy disk. insert it now.

Wwhat do you want the wizard to do?

Click Mest to continue.

[ Mest » ][ Cancel ]

Figure 2-21 Hardware Update Wizard: welcome window

Note  Refer to the Camera Installation Troubleshooter if you face problems during the camera installation (***)

Installation: Updating the Hardware

Download from Www.Somanuals.com. All Manuals Search And Download.



GETTING STARTED

To start the SMX-M8xx camera, connect it with the USB cable to your computer. Since
the camera is already installed (see chapter “Automatic Camera Installation” , see chapter
“Manual Hardware Installation” ), the corresponding icon should appear in the right corner
of the Taskbar:

o

Note  If noicon appears, refer to the Troubleshooter chapter of this Document and learn how to fix this problem

To start the SMX-M8X Camera Application open Start> Programs> Sumix > SMX-
M8X USB2.0 Camera > SMX-M8X> USB2.0 Camera Application Program (sce Figure
3-1 Opening the SMX-M8xx Camera Software).

ﬁ A0L for Broadband

B8 | 1CQ5.1

@( Set Program Access and Defaults

w Windows Catalog

% ‘windows Update

Programs

@ ACCEsSONEs
@ Microsoft Office
Documents S IF) SMx150USB2.0 Camera ¥
S ; @ Wwindows Media Player @ SM=-155 USBZ.0 Camera ¢

@ 12051 v [ SM-MEx LISBZ.0 Camera  »|[) AFI v
Search % adobe Photoshop €52 ¥ I Drivers 3
M~ Acrobat Distiler & a SME-Max USEZ.0 Camera Application Pragram
Help and Support = Adobe Acrobat & Professional -2‘ SMK-M3: USEZ.0 Camera User Guide
© adabe LiveCycle Designer 8.0 ﬂ Uninstall SMX-M&x USEZ.0 Camera Software

¥

Windows XP Professional

dcia) UH O~ Te] 09 34 su
Figure 3-1 Opening the SMX-M8xx Camera Software

Getting Started
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The SMX-M8X Camera Application will start and you will see its main window (see.
Figure 3-2 The SMX-M8X Camera Application main window outlook).

&) SMX-MBX Series USB2.0 Camera |- | [J
File Edit Device Help

o | m| @@ nc|ec| SN

I

— Sensor Control
— Exposure Gain Frequency
65.70 m= | 101.01.01.0 4 MHz -
—— Decimation
—— Wiewport [pix] —
1280 = 1024
= at0.0
Al R G B
I~ Lock Ratio

Image Correction | Color Balance I Color Correction

|~ Enable  Best I Default I
Brightress [~ 0
Contragt ©————— [~ 0
Gamma [ 1.00

Snapshot
[ Loop Snapshot

Timeout [sec]ﬁ | External Trigger —

SIM%-MB1 Colar Ready [ | Stopped

Figure 3-2 The SMX-M8X Camera Application main window outlook

To see the video captured by the camera, press F5 or click the Start Video button:

i

The View window will appear (see Figure 3-3 The SMX-M8X View).

Getting Started
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Figure 3-3 The SMX-M8X View

The SMX-M8xx Camera Application consists of 3 main parts:

® Application main window

® Histogram

® Device Settings window

Application main window contain:

® Sensor Controls, Image Correction

® Color Balance and Color Correction Controls (for color models only)
® Snapshot options

Histogram is reflecting all color settings that were done with the camera.
Device Settings window consists of:

Standard camera information

Color mode changing

Image flipping

Averaging frames

Exposure limiting

Frame rate controlling

Standard program options

8/10 bit modes

Getting Started -
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® Limit Gain 10

® Filtering

Getting Started
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Exposure

SENSOR CONTROL

Gain

The camera Exposure parameter is similar to exposure notion in photography. It
defines time for which the sensor elements are gathering the energy of light.

Use the Exposure slider to adjust the camera exposure time. The current exposure time
in milliseconds (ms) is displayed above the control. This value depends on viewport
height, decimation and sensor frequency.

To perform Autoexposure, in the Device menu select the Auto Exposure command or
simply press E keyboard.

Note:

Note:

Frequency

Use the Gain controls to change the signal gain of the sensor. Increasing Gain is
reasonable when light condition is poor and increasing time of exposure does not help.
For color models Gain can be controlled independently for Red, Green and Blue
channels (R, G, B).

Checking the Lock Ratio checkbox allows controlling gain on three channels
simultaneously keeping the fixed R, G, B gain ratio.

All the Gain sliders control the camera's hardware gain amplifier. The R, G and B gain
sliders control the software gain for each color channel.

Use the 'White balance (Hard)' menu item (Device> White Balance (Hard) or the
'Alt+W' keyboard shortcut to balance Gain of all three channels so they are equally
intense.

The R, G, B channels are disabled when running the SMX-M81M Camera, as well as White Balance (Soft) and
White Balance (Hard)

Auto Exposure is done automatically every time White Balance (Hard) is performed

This control defines the pixel clock frequency of the sensor. The lower Frequency, the
higher maximum possible Exposure time and the lower Frame Rate (see chapter “Frame

Rate Control”). Use the dropdown menu (near the Gain and Exposure controls) to define
Frequency.

Sensor Control: Exposure
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Decimation

Use the Decimation control to decimate (sub-sample) the picture by 2, 4, etc. The
decimation means excluding pixels and rows from the scan process (e.g. every second
pixel and second row for the 1:2 decimation). This mode thus allows viewing the full
picture at the higher Frame Rate (see chapter “Frame Rate Control” ). The decimation can
be used for preview, when the full 1600x1200 image displayed as 800x600 with the
frame rate twice higher. Use its dropdown menu to change Decimation.

Viewport Settings

Viewport is a rectangular area of the sensor on which the image is scanned. It can have
variable size, from the smallest area of 8x8 pixels to the full field of view of the sensor.
The smaller the size of the Viewport, the faster the scan process, and the higher Frame
Rate (see chapter “Frame Rate Control”). To open the Viewport Settings dialog (see Figure
4-1 Viewport Setting dialog: the case of the SMX-M82C Camera), press Alt+V or click the
corresponding button on the toolbar:

il

[ Yiewport Settings .

Cloze

Fredefined
" 320x240
" 400x400
" B40x480
(" TEExETE
(" 800x600
" 1024x768
" 1280x1024
(v 1600x1200

ofiset %[00 y[0 Size: % [1600 v [1200
Figure 4-1 Viewport Setting dialog: the case of the SMX-M82C Camera

The blue rectangle represents the current viewport window related to the full possible
field of view. Drag the rectangle across the full resolution area for the viewport panning.
The changes are displayed in the View window immediately.

Use the boxes in the bottom part to set the viewport offset and size manually and click
the Apply button to apply the settings. The values should be divisible by 8 and will be
rounded and applied automatically within 2 seconds after last keystroke.

Sensor Control: Decimation
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Use one of the radio buttons on the Predefined control to set one of the predefined
viewport sizes. The Viewport rectangle position may also be changed by dragging the
video image in the View window.

Image Correction

Note:

Note:

Color Balance

The Image Correction controls are designed for setting up the camera's Brightness,
Contrast and Gamma (see Figure 3-2 The SMX-M8X Camera Application main window
outlook).

This correction is done programmatically by the camera firmware using the conversion
(look-up) table of the values. The correction does not affect any electrical settings of the
camera. To use the Image Correction controls, check the Enable command -
Brightness, Contrast and Gamma become editable.

The default values of Brightness, Contrast and Gamma are set to 0; 0; 1, 00,
respectively.

You can restore the default values of the Image Correction controls on any step of
changes: simply click the Default button on the Image Correction tab.

The Best button, if applied, activates application to transform the look-up table of 8
and10 bit to increase the dynamic range.

The SMX-M8xx Camera Software does not display changes of the Image Correction look -up table when the
Best button is applied

With every change of any image correction controls, you can view a graphical
interpretation of the dependence of the image's changes on the changes of the Image
Correction controls (see Figure 3-2 The SMX-M8X Camera Application main window outlook).

The default values of Image Corrections are the most suitable and recommended for performing White Bal-
ance (Hard)

The Color Balance controls are designed to adjust the ratio of the main induced color
components (Red, Green and Blue) on the image that is displayed by the camera
software.

This correction is done on the software level and does not affect any electrical settings
of the camera (see Figure 4-2 The SMX-M8X Camera Application Color Balance Controls).

Sensor Control: Image Correction
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Note:

Note:

Note:

& SMX-MBX Series USB2.0 Camera |- |

File Edit Device Help

T
> [[o i [ || S
Frequency

24MHz =

—— Decimation

Sensor Control
— Exposure Gain
65.70 m= | 101.01.01.0

11 hd
—— Wiewport [pix] —
1280 = 1024
at0.0

Settings...

Image Corection  Color Balance l Color Correction ]

Al R G B
I Lock Ratio

D efault | “white: Balance|

| 1.00

| 1.00

| 1.00

Snapshot
I~ Loop Shapshaot

Timeout zec) |5 %] [ Extemal Trigger
SME-M31 Color Ready Stopped

Figure 4-2 The SMX-M8X Camera Application Color Balance Controls

To use the Color Balance controls, check the Enable command - the R, G and B sliders
becomes editable.

Use the White Balance (Soft) button for balancing white color (same can be done on
Device> White Balance (Soft) or with the 'W' keyboard accelerator) in the Color
Balance tab.

The Default button restores the default values of the Color Balance controls: 1, 00; 1,
00; 1, 00, respectively.

A single step of each Color Balance control is 10 times smaller than R, G,

B (Gain) of Sensor Controls, so all changes of Color Balance are performed with more
exactness than using R, G, B (Gain) of Sensor Controls.

The difference between White balance (Soft) and White Balance (Hard) is as follows. The White Balance
(Soft) operation is done only on the software level, so it changes the Color Balance Controls. The White Bal-
ance (Hard) operation is done programmatically by the camera firmware, so it changes R, G and B (Gain) of
Sensor Controls

It is not recommended to perform White Balance (Hard) when White Balance (Soft) is already performed. It
may cause the image colors distortion

The Color Balance tab is disabled when running the SMX-M81M Camera (sce Figure 4-4 Application’s main
window outlook when using the SMX-M81M Camera)

Sensor Control: Color Balance
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Color Correction

Note:

Note:

The Color Correction controls are designed to adjust the intensity of the color
properties (Brightness, Contrast and Saturation) of the image that is displayed by the
camera.

This correction is also done on the software level and does not affect any electrical
settings of the camera.

Check the Enable command to make the Color Correction controls available.

Use the Default button to restore the default values of Brightness, Contrast and
Saturation - 0,0; 1,00; 1,00, respectively (see Figure 4-3 The SMX-M8X Camera Application
Color Correction Controls).

& SMX-MBX Series USB2.0 Camera |- |

File Edit Device Help

>|o|=|w| s SN

Sensor Control
— Exposure Gain Frequency
65.70 m= | 101.01.01.0

24MHz =

—— Decimation

11 hd

—— Wiewport [pix] —

1280 = 1024
at0.0

Al R G B St
[~ Lock Ratio e

Eorrection] Color Balance  Color Correction l

] D efault
Brightness T I 0.00
Contrast T | 1.00
Saturation I 1.00
Snapshot
I~ Loop Shapshaot

Timeout zec) |5 %] [ Extemal Trigger

SM¥-M31 Color Ready Stopped

Figure 4-3 The SMX-M8X Camera Application Color Correction Controls

Use of the Controls done on the software level (Color Balance, Color Correction, White Balance (Soft), etc)
may cause an overloading of the computer's processor, especially when more than one camera is running

The Color Correction tab is disabled when running the SMX-M81M Camera (see Figure 4-4 Application’s main
window outlook when using the SMX-M81M Camera)

Sensor Control: Color Correction
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[SE) ]

a SMX-M8x Series USB2.0 Camera

File Device Help
>| o] & | @ || SO

— Sensor Control
— Exposure Gain Frequency

98,93 ms | 10 10 10 10
‘ |24MH2 vl

—— Decimation

11 hd
—— Wiewport [pix] —
1280 = 1024

— at0. 0

Al R G B .
Settings... |

I~ Lock Ratio

Image Correction |

|¥ Enable  Best I Default I

Brightress [~ 0
Contragt ©————— [~ 0
Gamma [ 1.00

5 o
[ Loop Snapshat

Timeaut [sec]|5 vl [~ Esternal Trigger —
Lancel

[Zoom 1 [19Fps

SMX-ME1 Mono Ready
Figure 4-4 Application’s main window outlook when using the SMX-M81M Camera

Sensor Control: Color Correction
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SNAPSHOTS

Snapshots Basics

The SMX-M8xx Series Camera has two modes of operation: Video and Snapshot.
When the camerais not in the Video mode, it is possible to take a Snapshot - to capture
a stillimage. For the SMX-M8xx series cameras a Snapshot can be triggered by software
only.

Video is the normal mode when the camera is giving out the image data. The mode is
On when View window is open. The Snapshot mode forces the camera to capture the
still image (a single frame).

To take a Snapshot from the camera, use the Snapshot section of the SMX-M8X Series
USB2.0 Camera window. Remember that you need to Stop Video (Shift+F5) in order
to turn on the Snapshot mode.

The Snapshot button starts the snapshot process.

To take a Snapshot using software trigger, do the following:
1. Turn the video mode off(Shift+F5)

2. Set Exposure, Gain, Viewport, etc

3. Click the Snapshot button or press F9

The Snapshot View window will open (see Figure 5-1 The Snapshot View window).

29 Snapshot View Zoom 1x -|of=|

Figure 5-1 The Snapshot View window

Snapshots: Snapshots Basics
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Note:  In the Video mode, the Exposure slider controls the exposure time for the video. When the video is stopped, the
Exposure slider controls exposure time of the snapshot

For a continuous sequence of Snapshots, use the Loop option (see Figure 5-2 Running
the Snapshot Loop mode):

1. Check the Loop checkbox

2. Click the Snapshot button

-

D

Q SMX-M8x Series USB2.0 Camera
File Device Help

x| @] oo SN

Sensor Control
— Exposure Gain Frequency

98,93 ms | 10 10 10 10
‘ 24MHz =

—— Decimation

I

11 hd

—— Wiewport [pix] —
800 « 600

at 400, 300

Al R G B St
[~ Lock Ratio e

Image Carrection l Calor Balance ] Caolor Correction ]

:  Best Drefault

Contrast ™|~ O
Gamma [ 100

Snapshot

v Loop
Timeout zec) |5 %] [ Extemal Trigger

Cancel

Shd-m82 Color Ready Zoom Tx 3ips

Figure 5-2 Running the Snapshot Loop mode

The stream of continuous snapshots will be displayed in the Snapshot View window
(see Figure 5-1 The Snapshot View window). This mode can be useful to adjust the picture
parameters for the Snapshot mode.

Click Cancel or uncheck Loop to stop capturing.
Timeout - defines time during which the SMX-M8X Software is waiting for a Snapshot.

Use the spin buttons to increase or decrease time of waiting for a Snapshot.

Snapshots: Snapshots Basics
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Note:

Note:

Note:

SWITCHING BETWEEN
CAMERAS

If you have more than one SMX-M8xx Series Camera connected to your PC, the SMX-
M8X Camera Application allows you to switch between them.

To switch between the multiple cameras, do the following:
1. Inthe Device menu, select the Switch Multiple command. The 'Choose a Cam-
era..." window will appear (see Figure 6-1 Choosing active camera).

&) Choose a Camera... =&

1: Sh=-ME3 Color Camera [1013]

()8 | Cancel |

Figure 6-1 Choosing active camera

2. From the list of available cameras select the one you want and click OK.

When more than one camera is running on the same computer, the speed of each camera decreases as well as
Frame Rate (see chapter “Frame Rate Control”)

Every opening of the application automatically detects the first connected camera. So, when connecting more
than one camera to the computer you should perform the Switch Multiple... action to choose the right camera
before running

It is not recommended to run twice the same camera (to start video of one camera with 2 applications). This may
cause stopping of the camera's work

Switching Between Cameras
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Switching Between Cameras
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Camera Info

CAMERA DEVICE
SETTINGS

The Device Settings dialog is activated with Alt+S or by selecting Settings...in the

Device menu.

Device Settings
Camera Info

Shdx<-82 Color ISB2.0 Camera

Max Resolution: 1600x1200 Cloze

Device ID: 1.7.1.20

Color Mode Flip Image Average Frames
" Monochrome . (+ Disable
" Mearest Calor I Horizontal |~ | a5t N frames

 Vettical " Pack M frames
: ertical
" Laplacian Frames: |10 %

External Trigger Polarity Max Exposure
[~ Limit Max Exposure

Fosit =
ozitive "IDD— e

I Direct Access Ta Driver Frame Memary  FrameRate ...

Iv¥ Enable Image Comrection [ 10 bit mode
I Display Video on Program Startup [ Median Filer
I~ &uto White Balance Hardware I~ Limit Gain 10
[~ &uto White Balance Software

[~ Show Only alid Frames

Figure 7-1 Device Settings window for the SMX-M8xC Cameras

Color Mode

The Camera Info section contains information about the currently installed camera. It

consists of:

@ The Camera type - the type of the camera that is connected

® Maximal resolution (depends on the camera type)

® ID of the camera

The Color Mode section defines rules for decoding source pixels stream from the sensor
and transforming it into the output image. This control is available for the color models

only:

® The Monochrome mode forces transformation of sensor pixels data into mono-

chrome stream

Camera Device Settings: Camera Info
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® The Nearest Color mode: the Bayer matrix from sensor is transformed into destina-
tion stream using the Nearest Color algorithm (the fastest algorithm that gives the
worst image quality (compared to other algorithms)

@ The Bilinear mode: the Bayer matrix from sensor is transformed into destination
stream using Bilinear algorithm (slower algorithm that gives better quality)

® The Laplacian mode: the Bayer matrix from sensor is transformed into destination
stream using Linear Interpolation with Laplacian second-order correction terms (the
slowest algorithm that gives the best quality)

Note:  The Color Mode section is disabled when running the SMX-M81M Camera (sce Figure 7-2 Device Settings win-
dow for the SMX-M81M Cameras)
Device Settings
Camera Info
Stdx<-M81 Mono USB2.0 Camera
Max Resolution: 1280x1024
Device |D: 1405.8.6.12.30
Color Mode Flip Image Average Frames
= . {+ Disable
- I Horizantal ||~ | 2o N frames
e~ B Vel " Pack M frames
ertical
r Frames: |10 =
External Trigger Polarity Max Exposure
m [~ Limit Max Exposure
ositive =
100 ms
v Direct Access Ta Driver Frame Memary  FrameRate ...
Iv¥ Enable Image Comrection [ 10 bit mode
I Display Video on Program Startup [ Median Filer
I~ I Limit Gain 10
-
Figure 7-2 Device Settings window for the SMX-M81M Cameras
°
Flip Image

Use Flip Image controls to flip the image horizontally and/or vertically

@ Horizontal flipping is done by the camera software (as a result, frame rate may
decrease, see chapter “Frame Rate Control”)

® Vertical flipping is done by the camera hardware

Average Frames

The Average Frames controls are used to increase the image quality by compensating
the random noise of the sensor

There are two averaging modes:

@ Last N frames: the currently displayed frame is the average of the last N frames. The
picture is updated every frame

Camera Device Settings: Flip Image
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® Pack N Frames: the currently displayed frame is the average of the last N frames. The
picture is updated every Nth frame

Note:  Use averaging only for static pictures. Displaying moving objects in the average mode will lead to the image blur-
ring

Max Exposure

The Max Exposure scales the exposure slider bar. This option is useful to setup the
short exposure time.

To limit the maximal value of Exposure, do the following:
1. Enable the Limit Max Exposure command

2. Enterin the field the new maximal value of Exposure
3. Click the Set button

The maximal value of Exposure should be change to the one you entered.

Note:  The default maximal value of Exposure is different for each frequency. So, the maximal value that can be used
for limiting Exposure is 16 times greater than its default maximal value, for each frequency.

Direct Access To Driver Frame Memory

The Direct Access To Driver Frame Memory option can be used to reduce CPU load by
providing direct pointer to the driver frame memory instead of copying the frame to the
user buffer. See the APl documentation for the details.

Enable Image Correction

Enable Image Correction enables Brightness, Contrast and Gamma of the Image
Correction controls.

Display Video on Program Startup

Checked Display Video on Program Startup starts the video display immediately after
the program starts - there is no need to click the Start Video button.

Auto White Balance Hardware

Checked Auto White Balance Hardware performs White Balance (Hard)
automatically every time when you move the Brightness, Contrast and Gamma sliders
of the Image Corrections tab.

Note:  Auto White Balance Hardware is disabled when running the SMX-M81M Camera

Camera Device Settings: Max Exposure
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Auto White Balance Software

Note:

Checked Auto White Balance Software performs White Balance (Soft) automatically
every time when you move the Brightness, Contrast and Gamma sliders of the Image
Corrections tab.

Auto White Balance Software is disabled when running the SMX-M81M Camera

Frame Rate Control

Note:

Note:

The speed of the camera is measured in fps (frames per second). The value means the
number of frames (images) given by the camera per second. In the SMX-M8X Camera
Software the option of controlling the current number of frames per second is called
Frame Rate Control.

You can see the frame rate value in the right corner of the status bar in the main window
of the SMX-M8X Camera Application.

To open the Frame Rate Control window, click the Frame Rate... button in the Device
Settings window. The Frame Rate Control window will open (see Figure 7-3 Frame Rate
Control window).

Frame Rate Control

Frame Fate: [10.258 [fps]

Set Default | Set Maximum|

Figure 7-3 Frame Rate Control window

The Set Default button sets the default value of frame rate for the camera with current
settings. The default value is flashed in every camera and is applying automatically
when the camera's settings are changed.

It is recommended to use the default value of frame rate as the most suitable for the Snapshot Loop mode
The Set Maximum button sets the maximal possible value of frame rate for the camera
with current settings.

To change the Frame Rate value manually, do the following:
1. Open the Frame Rate Control window

2. Inthe Frame Rate field enter the value you need

3. Click Set

The current frame rate value should change according to the one you entered in the
Frame Rate Control window. Check it when running video: the frame rate value will be
displayed in the right corner of the status bar of the main application window.

The real frame rate value may vary in the range of 2-3 steps and even lower if you use a low-speed computer

To restore the maximal or default value of frame rate, do the following:

Camera Device Settings: Auto White Balance Software
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1. Click the Frame Rate... button to open the Frame Rate Control window
Click the Set Maximum button to get the maximal value or click the Set Default
button to get the default value

3. Close the window

Note:  When changing frame rate value manually, a warning message may appear. Usually it appears when the
entered value is lower than it is allowed. In this case, follow the instructions in the warning message (see Figure 7-
4 Warning message of the Frame Rate Control window)

.
Warning!

Flease set higher frequency or smaller height/width of viewpart!

Figure 7-4 Warning message of the Frame Rate Control window

Output Bits per Pixel Control

10 bit - enables the software to transmit 10 bit images from the camera as opposed to
regular 8 bit.

Median Filter

Median filter - turns on pixel averaging. The brightness of every single pixel becomes
affected by the brightness of its neighbor pixels and the whole image becomes
smoother.

Limit Gain

Limit Gain 10 - limits maximal value of Gain to 10.

Camera Device Settings: Output Bits per Pixel Control
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Camera Device Settings: Limit Gain
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PROFILES

The SMX-M8X Camera Application automatically stores all the camera and interface
settings on exit and restores them on startup.

Also you can store current settings in the Profile files (*.pro) and load them whenever

you need. Profiles are program settings saved as files. The number of stored profiles is
not limited.

To save current settings to a profile, press Ctrl+S or in the File menu select the Save
Profile command. To load a profile, press Ctrl+0 or in the File menu select the Open
Profile command.

Profiles
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Profiles
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CAPTURING

The SMX-M8X Camera Application allows user to capture images from the camera and
to store them as BMP or TIFF files.

To open the Capture Options dialog, do one of the following:

® Press Alt+C

® Open File>Capture Options...

The SMX-M8X Capture Options window will open (see Figure 9-1 SMX-M8X Capture
Options window).

SMX-M8x Capture Options

Picture File Store Folder
|E:\Program FilezhSumix\Shi-ME< USBZ.0 CamerahDATAN g@

File Mame Prefizes

Single Frame |FRAME_ Fomat..
" BMP

Sequence ’T

Yideo WIDEO_

Lirnits

[~ Capture single frame as average of frames

+ TIFF |NONE =

Iv Limit sequence count to |5 frames

5 hat Save Ol
Capture a frame every 1000 TS B SrEpsit S Ty

Save Yideo to Memory

Capture Limit: |1 0K | Cancel |

Figure 9-1 SMX-M8X Capture Options window

The captured files are stored in the folder that can be selected in the Picture File Store
Folder field.

The files are named automatically by combining the corresponding File Name Prefix
and numerical value that is calculated by the number of last captured file + 1; for
example, if the last captured file found is "FRAME_15.BMP" then the next file will be
named as "FRAME_16.BMP". The file name prefixes for single frames and frame
sequences can be set independently.

The Limits section allows controlling the sequence capture parameters.

For example, there will be a sequence of 5 frames (the 'Limit sequence count to' field)
captured one by one every second (1000ms, the 'Capture a frame every' field, see.
Figure 9-1 SMX-M8X Capture Options window).

Capturing
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Capturing

Note:

Note:

The sequence capture interval cannot be less than current frame exposure time. If it is, the error message will be
displayed when a user tries to perform the sequence capture

To perform the single frame capture procedure, press F2.

To perform the frame sequence capture procedure, press F3. To stop the sequence
capture, stop the video stream by clicking the Stop Video button:

o]

Sequence recording is automatically stopped when the number of saved frames
reaches the sequence count limit.

The Snapshot Save Only option allows saving snapshots without showing it on the
screen.

When this option is selected and the command to save snapshot is given, snapshot will
be not shown on the screen but saved in the specified folder (the 'Picture File Store
Folder' field).

You can save the video stream from the SMX-M8xx camera to .avi file. Start saving
video by pressing F4 or the Save Video toolbar button:

B

Using the Stop Video button will stop the saving video process.

When you open video .avi file right after it was saved, stop the video stream. Otherwise the file will not be avail-
able

You can also take advantage of the faster video saving method invoked by the Save
Video To Memory (Shift+F4) button:

o

When you click the Stop Video button, capture will stop and the SMX-M8X
Application will flush the .smx file to the specified folder (the 'Picture File Store
Folder' field). This file can be replayed and converted to .avi with the SMXView utility
that comes with the standard SMX-M8X software package. Saving video directly to
memory can slow down the camera's output visualization but this method insures that
no frames are missed from the saved file.

Use the Save Video to Memory option to limit the number of grabbed frames when
save video to the memory (the 'Capture Limit' field).
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Captured file can be saved as BMP or TIFF image file.

Capturing with BMP format saves any 8 bit or 10 bit image as 8 bit BMP image.
Capturing with TIFF format saves 8 bit image as 8 bit TIFF image and 10 bit image as
10 bit TIFF image.

Note please, that some image editors can not open the captured 10bit TIFF image since they can not read 10bit
images (for example, Microsoft Paint will not open a 10bit TIFF image)

Use the dropdown menu near the TIFF radio button to specify saving TIFF image with
or without compression.
® NONE - to save image with TIFF format without compression

® LZW - to save image with TIFF format with LZW (Lemple-Zif-Welch) - lossless type of
compression, supported by TIFF format

Capture functions, buttons and menu items are enabled only if Video is started (F5)

Capturing
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Capturing
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Overview

(GUIDELINES FOR USING
TWAIN DRIVER

Note:

Installation

To get a picture from the SMX-M8xx Camera you can use the Scanners and Cameras
operation - the standard Window's Administrative Tool (Start> Control
Panel>Scanners and Cameras).

You can also use almost any of the image editing programs to get the image from the
SMX-M8xx Camera using Scanners and Cameras. This action is available in almost all
image editing programs.

The information in this section of the document is based on the image editor that is
always available in Windows XP - Microsoft Paint.

To use the SMX-M8xx Camera for getting images, you should first install the required
software - TWAIN Driver.

Installation and use of TWAIN Driver requires that the needed hardware for the camera
use is already installed (see chapter “Installation”).

Installation and further use of TWAIN Driver is supported only by Windows XP operating system

How It Works

If the TWAIN Driver was installed during the SMX-M8x USB2.0 Camera Software
Package installation (see chapter “Automatic Camera Installation”), it is ready to be used.

If the TWAIN Driver was not installed during the SMX-M8x USB2.0 Camera Software
Package installation (see chapter “Automatic Camera Installation” ), browse to the Sumix
folder where the SMX-M8xx USB2.0 Camera was installed and open the \SMX-M8X
USB2.0 Camera\Drivers\TWAIN folder. In order to install the TWAIN Driver run the
SMXMB8WIA application file. Wait a few minutes for the driver installation to complete.

TWAIN Driver is installed and ready to be used.

Location

Open the Control Panel window (Start>Control Panel) and open Scanners and
Cameras (see Figure 10-1 Scanners and Cameras in the Control Panel window).

Guidelines for Using TWAIN Driver
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‘Windows Update p |
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@) Help and Support 5
Regional Scheduled Sound  Sounds and  Speech  Symantec System  Taskbar and
and La... Tasks Effect...  Audio De... Livellpdate Skark Menu
User
Accounts

Figure 10-1 Scanners and Cameras in the Control Panel window

Since TWAIN Driver is already installed, the SMX-M8X Series USB2.0 Camera WIA
should be available (see Figure 10-2 Scanners and Cameras).

- Guidelines for Using TWAIN Driver
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‘=%, Scanners and Cameras E]@
#

File  Edit Wiew Favorites Tools  Help

@Back . ? /'__ ) Search Folders v

Address 'S Scanners and Cameras 54 . Go
T SME-MEY Series 1USE2.0 Camera WA
Imaging Tasks k3

[3] Add an imaging device

b

Other Places

G- Control Panel

& My Documents
|5) Shared Documents
\3 Iy Metwork Places

b

Details

Scanners and Cameras
Syskem Folder

Figure 10-2 Scanners and Cameras

Now you can use the SMX-M8X Series USB2.0 Camera WIA to get the image from your
camera.

Getting Image Using Scanner and Camera Wizard

To get the image using the Scanner and Camera Wizard, do the following:

1. Connect the SMX-M81M, SMX-M82C or SMX-M83C USB2.0 Camera to your com-
puter

2. Open Control Panel>Scanners and Cameras

3. Select the SMX-M8X USB2.0 Camera WIA and do one of the following:

® Right-click and select Get picture using Scanner Wizard (see Figure 10-3 Selecting

Scanner Wizard for getting image from camera)

® Double-click the selected

Welcome to the Scanner and Camera Wizard will appear (see Figure 10-4 The Scanner
and Camera Wizard welcome window)

Guidelines for Using TWAIN Driver
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‘=%, Scanners and Cameras

File  Edit View Favorites Tools  Help

O Back ~ () ? 7 ) Search Folders Elv

Address |'< Scanners and Cameras
0 SME-MBY Series USEZ.0 Camera Ta
Imaging Tasks kS Scan

Get picture using Scanner Wizard
gi- et pickures

) ) ) Delete
Wiew device properties
Rename

Properties
Other Places 2

[ Control Panel

u My Documents
) Shared Documents
\,JJ Iy Metwork Places

b

Details

SMX-M8X Series USB2.0
Camera WIA
Irnage scanner

BETX

w aGo

Figure 10-3 Selecting Scanner Wizard for getting image from camera

> Scanner and Camera Wizard

Welcome to the Scanner and Camera
Wizard

ShAxMEX Series USB2.0 Camera WA

Thiz wizard helpz you copy pictures from your camera, scanner, or other
device to your computer, your network, or the Web,

To continue, click Next.

[ Mest> |[ Cancel ]

Figure 10-4 The Scanner and Camera Wizard welcome window

4. Click the Next button to go to the next step of the Scanner and Camera Wizard

(see Figure 10-5 Scanner and Camera Wizard: selecting scanning preferences)

Guidelines for Using TWAIN Driver
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> Scanner and Camera Wizard

Choose Scanning Preferences
Choose your scanning preferences, and then click Preview to see how your preferences affect

the picture.
Ficture type:
Ofoerpicrs W |
El () Grayscale picture E
() Custom E
Custom gettings E
B

Freview

[ < Back ” Mest » ][ Cancel ]

Figure 10-5 Scanner and Camera Wizard: selecting scanning preferences

5. Select Picture Type and adjust the image's settings (see Figure 10-5 Scanner and Cam-
era Wizard: selecting scanning preferences):

@ Color picture - to get the colorimage
® Grayscale picture - to get the black-and-white image

® C(lick the Custom Settings button to adjust properties of the image (see Figure 10-
6 Scanner and Camera Wizard: Advanced Properties window)

>

Choose Scanning Preferences
Choose your scanning preferences, and then click Preview to see how your preferences affect

the picture.
Ficture type: |
I: Properties
|: Advanced Properties |
Appearance
|: Brightness:
J a
Contrast:
J a
Fiesolution [DPI): Ficture type:
150 : Color picture i_v_:

[ ok | [ concel | [Hest>

Figure 10-6 Scanner and Camera Wizard: Advanced Properties window

Guidelines for Using TWAIN Driver
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6. Click the Preview button to view the image from the camera to be scanned (see Fig-

ure 10-7 Scanner and Camera Wizard: previewing)

> Scanner and Camera Wizard

Choose Scanning Preferences
Choose your scanning preferences, and then click Preview to see how your preferences affect

the picture.

Ficture type:

(O Colar picture

(O Grayscale picture

(&) Custom
Custom gettings

B

[ <Back || Mest> |[ Cancel ]

Figure 10-7 Scanner and Camera Wizard: previewing

7. Resize the image if needed
8. Click Next to go to the next step of the Scanner and Camera Wizard (see Figure 10-

8 Scanner and Camera Wizard: picture name and destination window)

> Scanner and Camera Wizard

Picture Name and Destination
Select a name and destination for your pictures,

1. Tuvpe aname for thiz group of pictures:

| Picture]

2. Select a file format;

%) TIF (TIF File) ]

3. Choose a place to save thiz group of pictures:

|io R [V] [ Browse...

[ < Back ][ Mest » ][ Cancel ]

Figure 10-8 Scanner and Camera Wizard: picture name and destination window

Guidelines for Using TWAIN Driver
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9. Input the name, select file format and choose the location where you want to save
your picture

10. Click the Next button - the Scanner and Camera Wizard starts scanning your pic-
ture (see Figure 10-9 Scanner and Camera Wizard: scanning picture)

’3 Scanner and Camera Wizard

Scanning Picture
Fleaze wait while the wizard scans your picture,

Location:
gram FileghSumixhShx-ME<LUSE2 0 Camera\DATA

Picture:
Picture 004

Ficture progress: 100% complete

To stop copying, click Cancel.

Cancel |

Figure 10-9 Scanner and Camera Wizard: scanning picture

11. After the Wizard finishes scanning a picture, you will be asked for other options of
the picture. Select the last option (see Figure 10-10 Scanner and Camera Wizard: other
options) and click Next

> Scanner and Camera Wizard

Other Options
*Y'ou can chooge to keep working with your pictures.

“Your pictures have been successfully copied to your computer or network.
*f'ou can alzo publish these pictures to a Web site or order printz online.
‘what do you want to do’?

(O Publizh these pictures to a'wWeb site
(O Order prints of these pictures from a phato printing 'web site

(®Mothing, I'm finished warking with these pictures

Leam mare about working with pictures.

[ < Back ” Mest » ][ Cancel

Figure 10-10 Scanner and Camera Wizard: other options

Guidelines for Using TWAIN Driver
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12. View the last window of the Scanner and Camera Wizard and click the Finish but-
ton (see Figure 10-11 Completing the Scanner and Camera Wizard window)

> Scanner and Camera Wizard

Completing the Scanner and Camera
Wizard

1 picture(s] were copied.

To zee your pictures on your computer or network,, click the location
below:
LC:MProgram Files\SumixhShx-tE USE2 0 CameratDATA

To cloze thiz wizard and zee your pictures, click Finish,

[ <Back | Finish |[ Cancel ]

Figure 10-11 Completing the Scanner and Camera Wizard window

Microsoft Windows will open the folder, where you saved the scanned image.

Getting Image Using Scan

To get the image using Scan, do the following:

1. Connect the SMX-M81M, SMX-M82C or SMX-M83C USB2.0 Camera to your com-
puter

2. Open Control Panel>Scanners and Cameras

3. Select the SMX-M8X USB2.0 Camera WIA and right-click. Select Scan (see Figure 10-
12 Scanners and Cameras: selecting Scan), as a result, a window with a list of available
programs will appear - the programs that are installed on your computer, to launch
for Scanning the image (see Figure 10-13 “Select the program to launch for Scanning”
window)

Guidelines for Using TWAIN Driver
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‘=% Scanners and Cameras E]@
File Edit View Favorites Tools Help ;','
@ Back - </ ? 7~ Search | Folders Elv
fddress | S Scanners and Cameras [ B

% SME-MBX Series LISB2 P o mmmnm s

P Scan
Get picture using Scanner Wizard

Imaging Tasks

gj- Get pictures
& e ) Delete
Wigw device properties Rename

Properties

b

Other Places

[} Control Panel

iD My Documents
|5) Shared Documents
&3 My Network Places

b

Details

SMX-M8X Series USB2.0
Camera WIA
Irnage scanner

Figure 10-12 Scanners and Cameras: selecting Scan

SMX-M8X Series USB2.0 Camera WIA

Initiate & new scan.

Select the program ta launch for thiz action:

]

“\I_'T- Fhotoshop
25 Photoshop

[ &hways use thiz program for this action

[ Ok, H Cancel ]

Figure 10-13 “Select the program to launch for Scanning” window

Some image editing programs that can be also used for scanning images might not be present in the list that is
shown (see Figure 10-13 “Select the program to launch for Scanning” window). It might be due to the current
operating system'’s settings or the image editing program configuration. For more information, see Help Topics
of Windows operating system about Scanners and Cameras or Help Topics of the corresponding program

4. Select the program most suitable for you and click the OK button. The selected pro-
gram will open and Scan Using SMX-M8X Series USB2.0 Camera WIA will open
(see Figure 10-14 Scan using SMX-M8X Series USB2.0 Camera WIA window)

Guidelines for Using TWAIN Driver

Download from Www.Somanuals.com. All Manuals Search And Download.



SMX-M8xx Series USB2.0 Camera User Guide

Note:  Notallimage editing programs open the Scan Using SMX-M8X Series USB2.0 Camera WIA window (see Fig-
ure 10-14 Scan using SMX-M8X Series USB2.0 Camera WIA window) automatically - some of them just open the
program's main window. It depends on the program configuration. In this case, for more information see Help
Topic for this program

> Scan using SMX-MBX Series USB2.0 Camera WIA

What do you want to scan?

Select an option below for the type of picture pou
want to scan.

El (O Grayscale picture
(O Custom Settings

“f'ou can also: [BE - l

Adjust the guality of the scanned picture

[ Preview H Scan H Cancel ]

Figure 10-14 Scan using SMX-M8X Series USB2.0 Camera WIA window

5. Select Color or Grayscale picture or click the Adjust the quality of the scanned
picture link to change the image's settings. Click the Preview button to preview the
image to be scanned

6. When ready, click the Scan button - your image editor will start scanning and will
show the scanned image in the current program’s window

Getting Image from Camera Using Microsoft Paint

To get the image from the camera using Microsoft Paint program, do the following:

1. Open Microsoft Paint (Start>All Programs>Accessories>Paint)

2. Connect the SMX-M81M, SMX-M82C or SMX-M83C USB2.0 Camera to your com-
puter

3. In Microsoft Paint open File>From Scanner or Camera... - Scan Using SMX-M8X
Series USB2.0 Camera WIA will open (see Figure 10-15 Getting image from camera
using Microsoft Paint program)

Guidelines for Using TWAIN Driver
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? u.nlblltd Paint Liw
i
@ e
26
[7]8
™ A
R sing SMX-MBX Series USB2.0 Camera WIA
e What do you want to scan?
6
Select an option below fo the type of picture you
wank bo scan.
(5 | @ pia
|53 | © Grapscse potre
@ © Custom Seltings

You can also;
Azt the gualty of the scanned pichure

1 O I
—rMErRrFEECEC A

For Help, click Help Topics on the Help Menu. 16,82

Figure 10-15 Getting image from camera using Microsoft Paint program

4. Adjust the image's settings, click Preview to view the image that is scanned (see Fig-
ure 10-15 Getting image from camera using Microsoft Paint program)

5. When ready, click the Scan button

6. When done, save the scanned image (see Figure 10-16 Microsoft Paint: Image, received
after scanning)

Guidelines for Using TWAIN Driver
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w1 I
—FECNEEEC R

For Help, click Help Topics on the Help Menu.

Figure 10-16 Microsoft Paint: Image, received after scanning

Note:  To get more information about Scanners and Cameras operation, see the standard Window's XP Help Topics

Guidelines for Using TWAIN Driver
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MENU OVERVIEW

The Main menu includes three command groups described below.

File
Save Frame (F2) - saves a single frame as .bmp file to a location specified in Capture
Options
Save Sequence (F3) - saves a sequence of frames to a location specified in Capture
Options
Save Video (F4) - saves video as a video file to a specific location specified in Capture
Options
Save Video To Memory (Shift + F4) - starts saving video to memory to a location
specified in Capture Options
Capture Options... (Alt+C) - opens the Capture Options window
Load Profile (Ctrl+O) - opens the Load Camera Profile window
Save Profile (Ctrl+S) - saves all settings to Profile
Exit - closes the application

Edit
Copy (Ctrl+C) - copies an image from the camera to buffer

Device

Start Video (F5) - starts video stream

Stop Video (Shift+F5) - stops video stream

Viewport Settings...(Alt + V) - opens the Viewport Settings window

Auto Exposure (E) - performs auto exposure

White Balance (Soft) (W) - performs white balancing on software level

White Balance (Hard) (Alt+W) - performs white balancing on Hardware level
Histogram (H) - opens the Histogram view

Snapshot (F9) - saves single snapshot as .omp file to a location specified in Capture
Options

Menu Overview: File
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Zoom In (Num +) - zooms in view

Zoom (Out Num -) - zooms out view

Original Size Num * - returns view to the Zoom=1x

Switch Multiple... - opens the Choose a Camera... window

Settings... (Alt+S) - opens the Device Settings window

Help

Help (F1) - opens the application help window
Version Info - opens window with the version information

About - opens the 'About’ window

Menu Overview: Help

Download from Www.Somanuals.com. All Manuals Search And Download.



KEYBOARD SHORTCUTS

Main Keyboard Shortcuts Operations

Table 2-1 Main Keyboard shortcut operations

Keyboard operations

Description

F1

Help

F2

Captures a frame to bitmap file

F3

Captures a sequence of frames to bitmap files

F4

Captures a sequence of frames to AVl file

Shift + F4

Capture a sequence of frames to the memory

F5

Starts live video display in the View window

Shift+F5

Stops live video display and closes the View window

F9

Takes a snapshot

F12

Brings up the Main window when displaying the live video

Esc

The same as Shift + F5, stops the video

Ctrl+ O

Opens Camera Profile

Ctrl+S

Stores Camera Profile

Ctrl+C

Copies an image from the camera to buffer

Alt+C

Brings up the Capture Options window

Alt+S

Brings up the Device Settings window

Alt+V

Brings up the Viewport Settings window

H

Brings up the Histogram

w

Performs White Balance (Soft) using Color Balance

Alt+W

Performs White Balance (Hard) using Gain Controls

Numpad +/-

Zoom In/Zoom Out the picture in the View window

Numpad *

Restores the picture in the View window to its original (100%) size

Keyboard Shortcuts: Main Keyboard Shortcuts Operations
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Keyboard Shortcuts: Main Keyboard Shortcuts Operations
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TOOLBAR OVERVIEW

Main Toolbar Operations

The most popular menu commands are duplicated on the application toolbar:

Starts live video display in the View window

Stops live video display and closes the View window

Brings up the Viewport Setup Dialog

Captures a frame to BMP/TIFF file

Captures a sequence of frames to BMP/TIFF files

Starts saving Video to a file

2 |7 (g[8 |= o |v

Starts saving Video to memory

Toolbar Overview: Main Toolbar Operations
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Toolbar Overview: Main Toolbar Operations
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BASIC GUIDELINES ON
USING THE SMX-M8XX
SERIES USB2.0 CAMERAS

Introduction

The SMX-M8xx Series Cameras - are megapixel CMOS cameras with USB2.0 interface.
The SMX-M8xx Series Cameras are available in three modifications:

® SMX-M81M (1.3 Megapixel, monochrome)

® SMX-M82C (2 Megapixel, color)

® SMX-M83C (3 Megapixel, color)

All the SMX-M8xx cameras feature small size and C/CS-mount form factor.

The SMX-M8xx cameras are supplied with C-mount adapter and/or C-mount adapter
with IR-cut filter for converting CS-mount to C-mount.

Camera Kit
The SMX-M8xx Camera Kit includes:
® SMX-M8xx Series Camera:

® The SMX-M8xx Series USB2.0 Cameras Software Package which is available for down-
loading via the provided URL

® USB A to USB mini-B cable (optional):

Basic Guidelines on Using the SMX-M8xx Series USB2.0 Cameras
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@ Tripod adapter (optional):

® C-mount adapter with IR-cut filter (optional):

® C-mount adapter (optional):

Basic Guidelines on Using the SMX-M8xx Series USB2.0 Cameras
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Use of C-mount Adapter with and without IR-cut Filter

Overview

The C-mount adapter is an adapter that converts the SMX-M8xx camera from SC-
mount (the initial form factor of the SMX-M8xx cameras) to C-mount.

The C-mount adapter with IR-cut filter is a C-mount adapter that additionally
contains a built-in IR-cut filter (see chapter “IR-cut filter Characteristics”).

Both color and monochrome camera models can be used either with C-mount adapter
or C-mount adapter with IR-cut filter.

IR-cut filter Characteristics
IR-cut filter is a color filter that blocks infrared light.
The IR-cut filter characteristics are as follows:
® Diameter =20mm

® Thickness =2 mm

Basic Guidelines on Using the SMX-M8xx Series USB2.0 Cameras
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Chart of the IR-cut filter transmission characteristics

When to Use the C-mount Adapter with IR-cut Filter

C-mount adapter with IR-cut filter use with the color cameras. Since the SMX-M8xx
color cameras are sensitive to IR-light, use the C-mount adapter with IR-cut filter for
the color camera models to make colors of the image more realistic.

Many light sources, including the sun, emit infrared light, so the color camera in daylight
will see a significant amount of infrared light without the IR-cut filter. As a result,
strange and non-realistic colors appear.

Another reason for using the IR-cut filter is the limited color correction for many lenses.
A lot of lenses have different depth of focus for the visible and infrared spectrum. The
IR-cut filter cuts away a significant amount of the overall collected light and thereby
affects the sensitivity in a negative way. In general, color cameras are one factor less
sensitive compared to monochrome (depending on the sensor). This is primarily due to
the IR-cut filter.

Basic Guidelines on Using the SMX-M8xx Series USB2.0 Cameras
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C-mount adapter with IR-cut filter use with monochrome cameras. The SMX-M8xx
monochrome cameras (the SMX-M81M cameras) are more sensitive to infrared light
than color models. Using the cameras in environment rich for infrared light may result in
highlighted images. In order to avoid highlighted images, use the C-mount adapter
with IR-cut filter for monochrome cameras.

Using the SMX-M8xx Camera as CS-mount

Using the SMX-M8xx camera as CS-mount means using it without both C-mount
adapter and C-mount adapter with IR-cut filter:

CS-mount:
without C-mount
adapter

Using the SMX-M8xx Camera as C-mount

Using the SMX-M8xx camera as C-mount means using it with the C-mount adapter or
with the C-mount adapter with IR-cut filter:

Basic Guidelines on Using the SMX-M8xx Series USB2.0 Cameras
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C-mount: with
C-mount adapter or
C-mount adapter
with IR-cut filter

CS-mount: without
both C-mount

adapter and C-mount
\A’ adapter with IR-cut fil-
C-mount adapter with ter
IR-cut filter or without
IR-cut filter

Converting the SMX-M8xx Camera from CS-mount to C-mount, from C-mount to CS-mount

Usually the SMX-M8xx camera goes with the C-mount adapter or C-mount adapter
with IR-cut filter already screwed in.

To use the SMX-M8xx camera as CS-mount screw the C-mount adapter/C-mount
adapter with IR-cut filter out.

To use the SMX-M8xx camera as C-mount screw the C-mount adapter/C-mount
adapter with IR-cut filter in.

Note  Itis recommended to install (as well as to remove) the C-mount adapter/C-mount adapter with IR-cut filter,
lens or the camera's cover when the camera is faced down or when the camera is in horizontal position - to pre-
vent the sensor contamination:

Basic Guidelines on Using the SMX-M8xx Series USB2.0 Cameras
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Use of Tripod Adapter with the SMX-M8xx Cameras

The SMX-M8xx camera may go with the Tripod adapter already on:

To remove the Tripod adapter from the camera:

Basic Guidelines on Using the SMX-M8xx Series USB2.0 Cameras
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1. Loosen the screw of the Tripod adapter
2. Remove the Tripod adapter from the camera:

To put the Tripod adapter on the camera, do the following:
1. Loosen the screw of the Tripod adapter
2. Putthe Tripod adapter on the camera and locate it as shown in the image below:

Basic Guidelines on Using the SMX-M8xx Series USB2.0 Cameras

Download from Www.Somanuals.com. All Manuals Search And Download.



SMX-M8xx Series USB2.0 Camera User Guide

Basic Guidelines on Using the SMX-M8xx Series USB2.0 Cameras

Download from Www.Somanuals.com. All Manuals Search And Download.



CAMERA INSTALLATION
TROUBLESHOOTER

Before following instructions of this chapter make sure that you follow all instructions
and recommendations that are described in the See “Installation” on page 11 chapter of
this Document.

If you face problems with installation and detection of the camera, use this
Troubleshooter.

If you face problems that are not described below, contact Sumix Technical
Department.

Camera was not Detected or Recognized

If after connecting the camera the system does not detect it: there is no icon

on your Taskbar; or the camera was not recognized by the system:

L\] USE Device Mot Recognized

One of the USE devices attached ko this computer has
malfunctioned, and Windows does not recognize it
For assistance in solving this problem, click this message.

try to:

® Checkif the device was installed successfully: open the following system folder: WIN-
DOWS> system32>drivers and check if the SMXM8X.sys file is present (normally it
is located on the C hard disk). If not, run the Driver installation again. Be sure that
no camera is connected during installation.

If the same problem still occurs, save manually the SMXM8X.sys file to the
WINDOWS>system32>drivers folder (the SMXM8X.sys file is located in the
\Sumix\SMX-M8x USB2.0 Camera\Drivers folder)

If you failed on previous step, try one of the following:

® Reconnect the camera

Camera Installation Troubleshooter: Camera was not Detected or Recognized
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Use other USB2.0 port(s) of your computer - the problem
USB2.0 port

Use another USB2.0 cable - the problem might be due to

more than one) - the problem might be due to the faulty

@ Disconnect the camera and restart the computer

might be due to the faulty

the faulty USB2.0 cable

Connect other (if any) SMX-M8xx camera to the same USB2.0 port(s) (if you have

camera

If none of the previous steps succeeded, and the device is not recognized yet, try to do

the following:
1. Connect the problematical camera to your computer
2,

Open the Device Manager window (right-click My Computer desktop icon, select

Properties, then select the Hardware tab, and click Device Manager)

3. In Device Manager select one of the following:

@ Imaging devices> SMX M8X Series USB2.0 Camera with the Warning status, if it

available:

Device Manager

M=%

File  Action YWiew Help

g 2 =R
=2 many
+ _éComputer
+-age Disk drives

+ .j Display adapters
+ b DYDJCD-ROM drives
+-{= Floppy disk controllers
+ j} Floppy disk drives
+- 9 Human Interface Devices
+-{=%y IDE ATAJATAPT controllers
=8 Imaging devices
=" ISME-M8% Series USB2,0 Camera;

z» Keyboards

"y Mice and other pointing devices
»z Monitars
+ @ Metwork adapters
- & Ports (COM &LPT)
+ ﬁ Processars
+-8), sound, video and game controllers

é System devices

Universal Serial Bus controllers

£
£

£

£
£

Universal Serial Bus controllers> Unknown device (in the case if no SMX-M8X

Series USB2.0 Camera with the Warning status available in the Imaging devices):

Camera Installation Troubleshooter: Camera was not Detected or Recognized

Download from Www.Somanuals.com. All Manuals Search And Download.



SMX-M8xx Series USB2.0 Camera User Guide

Device Manager

File  Action YWiew Help

g 2
+- ") Mice and other pointing devices ~
+- % Manitars |
+- B8 Network adapters
+- & Ports (COM &LPT)
+ ﬁ Processars
+-8), sound, video and game controllers
+ Syskem devices
= é Universal Serial Bus controllers

Genetic USE Hub

Intel{R) 82801EE USE Universal Host Controller - 2402

Intel{R) 82801EE USE Universal Host Controller - 2404

Intel{R) 82801EE USE Universal Host Contraoller - 2407

Intel{R) 82801EE USE Universal Host Contraoller - 24DE

Intel{R} 82801EE USEZ Enhanced Host Controller - 2400
Inkniowin Devic

USE Rook Hub
USE Rook Hub
USE Rook Hub

[v]
. . ' o N
4. Right-click and select 'Update Driver..."
Device Manag S]]
File  Action Wiew Help
HE 2
¥ Eg Monitors ]
+- EE Network adapters
w1 P Ports (COM&LPT)
+ m Processors
+ @ Sound, video and game controllers
+- ¢ System devices
- Universal Serial Bus controllers
Intel{R) 82801EE USE Universal Host Controller - 2402
Intel{R) 82801EE USE Universal Host Controller - 2404
Intel{R) 82801EE USE Universal Host Controller - 2407
Intel{R} 82801EE USE Universal Host Controller - 24DE
Standard Enhanced PCI ko USE Host Controller
Unknawin Devi 4.
s bl Update Driver. ..
USE Rook Hub :
Disable
USE Rook Hub Uninstall
USE Rook Hub
USE oot Hub | 3¢an for hardware changes |
USE Root Hub Properties |
-

Launches the Hardware Update Wizard For the selected device,

5. Select‘No, not this time’in the Welcome to the Hardware Update Wizard window
and click Next:

Camera Installation Troubleshooter: Camera was not Detected or Recognized
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Hardware Update Wizard

Welcome to the Hardware Update
Wizard

Wwindows will zearch for curent and updated software by
looking on your computer, on the hardware installation CO, or on

b site [with your permizzion).

Can *Windows connect to Windows Update ta search for
software?

(O Wes, this time: arly
(O Yes, now and gvery time | connect a device
(® Ma, nat this time

Click Mest to continue.

Mest » ][ Cancel

Run the Hardware Update Wizard the same way as the Found New Hardware Wizard
choosing the 'Install the software automatically (Recommended)"

Hardware Update Wizard

. Thiz wizard helpz you install software for:

S8 Series USB2.0 Camera

Z:') If your hardware came with an installation CD
~4i=? or floppy disk. insert it now.

Wwhat do you want the wizard to do?

(O Install fram a list ar zpecific location (Advanced)

Click Mest to continue.

< Back ” Mest » ][ Cancel

See the ‘Manual Hardware Installation’ chapter of the SMX-M8xx USB2.0 Camera
User Guide and follow its recommendations on this step (see chapter “Manual Hardware
Installation”).

If some problems occur during the manual hardware installation, read the next chapter
of this Troubleshooter (see chapter “Cannot Install the Hardware”).

If the system still fails to detect the camera after all these actions, described above,
contact Sumix Technical Department.

Camera Installation Troubleshooter: Camera was not Detected or Recognized
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Cannot Install the Hardware

If the Found New Hardware Wizard\Hardware Update Wizard failed to install the
hardware (the Wizard that starts after the first connection of the camera or the Wizard
that starts for updating the hardware; failure appears after you browsed to the needed
files for the installing):

Found Mew Hardware Wizard

Cannot Install this Hardware

The hardware was not installed becauze the wizard cannot find
the neceszary software,

when this computer connects to the Internet, Windows Update
will zearch for the right software and notify you if it becomes
available.

irJ Click Back if you have installation media such as a
" CD-ROM, or if you know the location of the software,

".)‘ Click Finizh to go to Help and Support Center for further
. help installing thiz hardware,

< Back ” Finizh ][ Cancel

Try to do the following:

1. Click Back in the Found New Hardware Wizard and select 'Install from a list or
specific location (Advanced)'

2. C(lick the Next button:

Hardware Update Wizard

Thiz wizard helpz you install software for:

Shdx-Ex Series USB2.0 Camera

Z:') If your hardware came with an installation CD
~4i= or floppy disk. insert it now.
1.

Wwhat do you want the wj

2

Click Mest to continue.

< Back Cancel

3. Select 'Search for the best driver in these locations.'
4, Check the 'Include this location in the search' checkbox

Camera Installation Troubleshooter: Cannot Install the Hardware

Download from Www.Somanuals.com. All Manuals Search And Download.



SMX-M8xx Series USB2.0 Camera User Guide

5. Browse to the Drivers folder - from the SMX-M8xx Camera CD or from the
Sumix\SMX-M8x USB2.0 Camera folder (located on the hard disk where you
installed the SMX-M8x Camera Software, normally it is C:\Program
Files\Sumix\SMX-M8x USB2.0 Camera)

6. Click the Next button:

Hardware Update Wizard

Please choose your search and installation options. o
3.

(%) Search for the best driver in these locations.

Uze the check boxes below to limit or expand the default search, which includes local
4, paths and remaovable media. The best driver found will be installed. 5

[ Search removable media (floppy, CO-ROM...)

Include this location in the search:

gram FileghSumixhShi-k8x LUSE 2.0 CameratDrivers | v

() Don't search. | will choose the driver to install

Chooze thiz option to select the device driver from a list. Windows does not guarantee that
the driver you chooze will be the best match for your hardware.

[ < Back Mest » ][ Cancel

7. Wait till the Wizard installs all needed files

Click Finish if installation passed successfully

Camera Installation Troubleshooter: Cannot Install the Hardware
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